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1. Overview 

ShakeAlert UserDisplay is a User-facing module of the ShakeAlert earthquake early 
warning (EEW) system. To notify Users and to rapidly and simply display 
earthquake alert information, we have developed this Java Application that runs on 
a User's computer and receives XML-messages from the ShakeAlert system.  
 
This UserDisplay shows the User's location and the estimated epicenter of the 
earthquake. As time elapses from the detection and notification of an event, the 
current locations of the P- and S-wave fronts are also shown, as well as the 
estimated magnitude, the predicted intensity of shaking at the User's site, and the 
remaining time until this shaking is expected to start. The UserDisplay pops-up 
automatically if a new earthquake alert message is received that exceeds the 
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minimum thresholds for magnitude, intensity, and probability that the User has 
specified (see section Menus > Top Menu Bar > Edit > Settings > Event Filter 
Parameters for details of the User threshold behavior). XML-messages received by 
the UserDisplay are stored locally on the User's computer and can be replayed. To 
ensure robust communication, the UserDisplay receives and displays heartbeats 
coming from the three algorithms and the DecisionModule of the ShakeAlert system. 
 
The ShakeAlert system is not yet ready for public use. We request that Users do not 
distribute the UserDisplay software to others, as they will not be informed about the 
progress of the EEW testing and/or may not understand the current limitations of 
the EEW prototype system. We also ask Users of the prototype system not to talk to 
the news media or judge the system performance, because they may not have 
enough information to explain unexpected system performance. Testing of the 
prototype EEW system is ongoing; the USGS is aiming to raise funds to build an 
actual EEW system that will be available to the public. 
 
2. Background 

Since 2006, scientists from Caltech, UC Berkeley, ETH Zurich, USC/SCEC, and USGS 
have been working on the development and implementation of a prototype 
earthquake early warning (EEW) system for the West Coast of the U.S. 
(www.shakealert.org). ShakeAlert combines the outputs from three independently 
running algorithms: Tauc-Pd Onsite, Virtual Seismologist, and ElarmS. ShakeAlert 
provides a continuum of earthquake alert information including rapid estimates of 
magnitudes, locations, and expected seismic intensities. Earthquake magnitude 
represents the amount of energy released and depends on the surface area of the 
rupture. Seismic intensity is the amount of shaking, and is a relevant measure for 
potential damage. 
 
Starting in 2012, the ShakeAlert UserDisplay was made available to a limited group 
of ‘Beta Test Users’ as part of our test of the EEW algorithms and software. During 
the ongoing testing phase, software modules may fail, and the system may be off-
line some of the time. Thus, it will not be reliable and should not be used to make 
important decisions. 
 
3. Download and Installation 

Currently, the ShakeAlert UserDisplay program is only being distributed to a limited 
number of partners to provide feedback/support for further development, or to co-
develop pilot projects to demonstrate the use of ShakeAlert earthquake early 
warning notifications and data streams in real-world applications. At this time, 
access to the ShakeAlert software requires authorization and a personal username 
and password issued for installation. 
 
Requests for authorization and a personal username and password should be 
directed to: 
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   Douglas Given 
   USGS Earthquake Early Warning Coordinator 
   doug@usgs.gov 
 
Do not share your personal username and password with others.  
 
The ShakeAlert early warning project maintains the right to refuse access to anyone 
at any time without notice. 
 
Once authorization is granted, proceed with the download. Programs can be 
downloaded from the CISN website: http://www.cisn.org. 
 
Step 1. Download software 
Installation programs are available at the following URL: 
http://www.cisn.org/eew/software/userdisplay. The website directory containing 
the software is protected with a generic password which will be provided to you. 
Please select the installation software appropriate to your operating system. It is 
recommended that you read the README file in the download directory for further 
information on system requirements, installation and relevant updates.  
 

 Mac: UserDisplay-X.X.X_yyyymmdd.dmg 
 Windows: UserDisplay-X.X.X_yyyymmdd.exe 
 Linux: UserDisplay-X.X.X_yyyymmdd.run 
 UNIX: UserDisplay-X.X.X_yyyymmdd.tgz    

(On UNIX, you will execute the script userdisplay/runUNIX.sh) 
 

Step 2. Install Program 
Uninstall any previous UserDisplay versions on your computer. For versions from 
2.5.0 onwards use the uninstaller in the program installation directory, or on 
Windows you can also use the general program uninstaller available through the 
Control Panel. To uninstall older versions: 

 Mac: drag the UserDisplay folder to the trash. 
 Windows: use the Control Panel uninstall option (Start menu > Control Panel 

> Programs and Features > right-click on a program and select uninstall). 
 Linux/Unix: delete the UserDisplay folder. 

 
If you want to keep the event files from the history folder of your old UserDisplay 
version, copy it to a temporary location before uninstalling as detailed above. Once 
you have installed the new version of UserDisplay, check the README file for 
instructions on where to copy the history files to in your new installation. 
 
When you run the installer you will be asked to accept the USGS End User License 
Agreement. 
 

http://www.cisn.org/
http://www.cisn.org/
http://www.cisn.org/eew/software/userdisplay
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When you run or execute the UserDisplay program, it will request your personal 
username and password.  Additionally, the first time you run the software you will 
need once more to accept the USGS End User License Agreement. 
 
The first time you run a new version of ShakeAlert you will need to manually enter 
your personal username and password. If you need to see your password in clear 
text during or after you enter it on the dialog, check the “Show PassPhrase” box. If 
you check the “Autologin” box under Settings you will not need to enter your 
credentials again unless you download a new version. Please note that you should 
only check the “Autologin” box once you have verified that your credentials are 
correct, by seeing the connection status change to green after your first log in. Also, 
remember to go into “Settings” and enter your latitude/longitude to set your 
location and your magnitude and intensity thresholds for receiving alerts. For 
further information on setting alert thresholds, or other parameters, please see 
section Menus > Top Menu Bar > Edit > Settings. 
 
On Windows or Mac OSX you can set the ShakeAlert UserDisplay to be restarted 
automatically when your computer is restarted. On Windows, the installer will set 
the auto re-start option by default. On Mac OSX, put the UserDisplay application 
program in the list of "Login items" for your user (System preferences > Users and 
Groups > Login Items). 
 
If you experience technical difficulties with the UserDisplay or have any comments, 
please contact: 
 
   Margaret Vinci (Caltech) 
   mvinci@gps.caltech.edu 
   626-395-3298 
   (for Users in Southern California) 
 
   Jennifer Strauss (UC Berkeley) 
   jastrauss@berkeley.edu 
   510-642-1067 
   (for Users in Northern California) 
 
   Bill Steele (University of Washington) 
   wsteele@uw.edu 
   (for Users in the Pacific Northwest) 
 
Additional information regarding the ShakeAlert earthquake early warning system 
can be found at http://www.shakealert.org.  
 
Recent earthquake information can be found at http://www.cisn.org or 
http://earthquake.usgs.gov. 
 

http://www.shakealert.org/
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The ShakeAlert UserDisplay is a platform-independent Java Application. The 
program has been successfully tested on Windows 7, 8, and 10; Windows Vista; 
Windows XP; Linux; and Mac OS X. The program requires Java version 1.8 or higher. 
Please follow the instructions of the installation manager. You must grant the 
UserDisplay access through your firewall to be able to receive alert messages from 
the ShakeAlert system. 
 
Once the program is fully installed, you should find a shortcut for the UserDisplay on 
your Desktop. Double-click on the icon and enter your personal username and 
password to start your ShakeAlert UserDisplay. Do not forget to turn on your 
computer’s volume so you can hear the siren and voice announcements when an 
alert message is received. 
 
Recent Changes 
Based on the feedback from our Beta Test Users and advances in algorithm 
development, the following changes to the UserDisplay were made: 
 
1) The latest 2.5.0 version offers the following improvements: 

 Support for multiple ShakeAlert servers in the production system, which 
runs duplicate infrastructure to maximize the likelihood that the system 
continues to perform in cases of hardware or other failures. You may note 
that multiple servers are listed under Settings (Menus > Top Menu Bar > 
Edit > Settings). 

 Updated list of towns, cities, and highways, to ensure map features are 
current and event information is more aligned with that reported by 
regional seismic networks, CISN display and USGS web pages. 

 Top menu bar has pulldowns with keyboard shortcuts (e.g. cancel alarms, 
replay events, etc.), detailed in the Menu section. 

 Ground motion symbols are changed to make the display clearer, with a 
circle denoting observed peak ground motions and inverted triangles for 
predicted peak ground motions. An example is shown in section Alert 
Information > Map. 

 The installation package for all platforms has been updated in order to 
make installation easier and to support more platforms. 

 
2) New features for the 2.5.0 version include: 

 Earthquakes displayed color-coded by age and magnitude: A history of 
prior events displays on screen, color-coded by age and magnitude. 
Events can be replayed by clicking on these symbols. Events disappear 
from the map a week after last playback. For further details see section 
Menus > Top Menu Bar > View > Experimental > Turn History Layer ON. 

 Updated station list: Displays approximate seismic station locations; for 
further details see section Menus > Top Menu Bar > View > Experimental 
> Turn Station Layer ON. Please note that this may affect display refresh 
speed. 
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 Intensity map: Displays a colored map of seismic intensity for the event 
alert. For further explanation, see Menus > Top Menu Bar > View > 
Experimental > Turn Intensity Layer ON. Please note that this may 
affect display refresh speed. 

 Check for Updates: Checks for available program updates; see Menus > 
Top Menu Bar > Help > Check for Updates. 

 
3)  Bug fixes for v2.5.0: 

 The Windows version of the installer now follows recommended 
installation of the executable program file into the Program directory. 
Each user of the computer will have their own preferences and history 
folders in a location with access permissions. 

 If the UserDisplay window has been minimized, a new event alert will 
now automatically pop-up the display on Windows. 

 The messages “Audio muted” and “THIS IS A TEST” have been made 
easier to read. 

 
4) ShakeAlert UserDisplay v2.5.0 requires Java 1.8 or newer. 
 
 
4. Menus 

There are three menu bars along the top of the ShakeAlert UserDisplay window.  
 

 
Figure 1: Menu bars 

Top Menu Bar 
The Top Menu Bar displays items that, when clicked, reveal pull-down submenus of 
choices to select. 

 UserDisplay – Click this drop-down to turn off alarms, cancel events, 
reconnect to program services, or exit. 

 Silence Alarms quiets a current alarm. You can also use keyboard 
shortcut Ctrl-s or click Silence button on Button bar. This feature 
mutes ONGOING alerts, for example to suppress audio alerts for 
distant earthquakes with long warning times that may be irrelevant to 
the User. 

 Mute All Alarms will silence all incoming and simulated alarms until 
the mute is deselected. You can also mute alarms by clicking the Mute 
checkbox on the upper right of the UserDisplay, or by using keyboard 
shortcut Ctrl-m. The keyboard shortcut will toggle Mute on and off. 
You may wish to use this feature if there is an ongoing event swarm, 
or if you work in a quiet environment where a visual alert is sufficient. 
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 Cancel Event stops an event alarm from proceeding, whether an actual 
alarm or an example simulation. If you cancel an event, you will no 
longer get updates of that event. Unless you are demonstrating 
ShakeAlert and making use of example simulations, you should 
not use the Cancel Event button, because it may result in you not 
receiving relevant alerts as earthquake parameters are updated (e.g. 
as earthquake rupture proceeds it may move closer to your location).  

 Reconnect to ShakeAlert Server will attempt to reconnect your 
UserDisplay to the ShakeAlert system; if successful, your Program 
Status Light will turn green (for more details on the status light, see 
the Button Bar section). 

 Reconnect to Time Server will sync your program with the NTP 
(official time) server. If you get message “NTP Status is currently OK”, 
you don’t have to reconnect or “restart” the NTP synchronization. 

 Exit will quit the UserDisplay. You can also click the Power-off icon to 
quit, located directly below on the Button bar (see Button Bar 
section). Note that this will completely close the program and no 
alerts will be received. Usual operation is not to exit the program but 
to close or minimize the UserDisplay window using the standard 
controls on the top right of the display (see section 
‘Minimize/maximize and close the UserDisplay window’). 

 Replay – Offers shortcuts to replaying recent events, incoming or simulated. 
 Play Event – Opens the Examples/History archive, so you can select a 

past event to replay 
 Replay Last Event – Reinitiates the very last earthquake alert recently 

played or received.  
 Edit – Access your program settings 

such as the servers you are connecting 
to, your latitude/longitude location, and 
other specified details.  

 Settings – Identical to the 
Settings button on the Button 
bar, click to open a dialog box to 
input various details: 
 User location (lat/lon). 

When you first install the 
ShakeAlert UserDisplay, your 
latitude and longitude will 
point off the California coast, 
to remind you to change this 
to your exact location. 
Convert your address to 
lat/lon at geocoder.us or 
www.latlong.net 

 Server Name and Port. Figure 2. Settings dialog box 
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Default values will be input here, e.g., port 61617 (or 443) for 
connection to the ShakeAlert server, and port 123 UDP for NTP 
server. Do not change these unless instructed to do so.  

 Checkbox for AutoLogin. Check this box if you wish to be 
automatically logged in each time you launch ShakeAlert 
UserDisplay. Enable only after you have confirmed that your 
Username and Password have been accepted. The password is 
encrypted when saved to disk, so please make sure you know your 
password before running any new version. 
 

Note: Any changes to Server Name, Port, or the AutoLogin checkbox 
will cause the Login dialog box to appear. 

 
 Checkboxes for Shuffle Servers and AutoVS. Leave these at their 

default status, which is checked. 
 VS30 Site Conditions [m/s]. Leave this at the default value. For 

further explanation of this quantity see the Advanced users section 
below. 

 
    Advanced users: Enter the Vs30 value (average S-wave velocity of 
the uppermost 30 m) at your location. This value is important for 
estimating the seismic intensity at your site, and will vary depending 
on the rock or soil type in your local area. Enter “0” if you do not 
know the Vs30 value at your site. The program will automatically 
determine a Vs30 value from a lookup table using the latitude and 
longitude you entered. 

 
 Event Filter Parameters. To beta test the ShakeAlert 

UserDisplay, your Minimum Magnitude and Minimum Intensity 
should be low enough to detect relatively small (and therefore 
frequent) earthquakes. Default value is usually 1.0. You can raise 
this value if desired, but not by too much. Please note that your 
filter settings are only applied to new event messages (the first 
alert issued for an event); if event parameters exceed your 
thresholds during subsequent alerts, it will still continue to be 
ignored by your UserDisplay. This behavior is due to be amended 
in a future release. 

 
    Advanced Users: You can specify three threshold parameters, 
which must all be exceeded before an event message received by the 
UserDisplay will be displayed as an alert. Thus, the parameters you 
set here will control the number of alert messages you will receive.  
 
Earthquake magnitude represents the amount of energy released 
and depends on the surface area of the rupture. Seismic intensity is 
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the amount of shaking, and is a relevant measure for potential 
damage. 

 
o Minimum Magnitude: Enter the minimum magnitude of 

events for which you will receive alerts. Take care in setting 
this value. The UserDisplay will receive messages for events 
with magnitudes “2.5” or above. These smaller events are not 
damaging, but can be used to test the alert system. If you set 
the minimum magnitude too high (e.g., “5.5”), you may not 
see any alerts in the following weeks or months. We 
encourage you to try different magnitude thresholds.  During 
the beta test period, we prefer that you use a small value 
(e.g.,“1.0”). 

o Minimum Intensity: Enter the minimum seismic intensity 
(MMI scale) to be expected at your location for which you 
want alerts. The scale, shown on the lower left of the 
UserDisplay screen, ranges from “1” (not felt) to “10” 
(extreme shaking). Bear in mind that you will not receive 
alert messages if you set the threshold too high. Start with a 
small value (e.g., “1.0”).  

 
 Minimum Probability of Correct Alarm. By default these 

settings are set to Moderate. You can choose other warning time 
settings, if desired.  

 
    Advanced Users: Although we are making the ShakeAlert system 
as robust as possible, we cannot preclude that any particular alert 
message is wrong. False alerts can result from many different 
causes, such as instrument failure, non-seismic events, noise, or very 
strong teleseismic (distant) earthquakes. ShakeAlert will often 
“know” that a certain alert message may be incorrect (e.g., if an 
"event" is detected by only one or two sensors, but other stations do 
not trigger) and is capable of providing an estimate of the 
“Probability of Correct Alarm” (PCA). The PCA has values between 
“0.0” and “1.0” meaning the alert was most likely incorrect or 
correct, respectively.  
    For simplicity, we have introduced three PCA levels: “low” 
(0<=PCA<=0.4), “moderate” (0.4<=PCA<=0.7) and “high” 
(0.7<=PCA<=1.0). Often, the PCA will increase or decrease as time 
passes after an earthquake is detected. If an earthquake occurs close 
to your location and you may thus experience strong shaking soon 
(i.e., the warning time is <= 10 seconds), you may want to receive all 
alert messages regardless of their probability. If the earthquake, 
however, is relatively far away (i.e., the warning time is > 10 
seconds), you may want to wait longer and allow the PCA to 
increase, to make sure that the alert is correct. We therefore 
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recommend specifying a small PCA value (“low” or “moderate”) for 
close events, and a high PCA threshold for distant events (“high”). 
 

 If you edit any of these settings, click OK. Click Cancel to discard 
changed settings you decide you do not want enabled. 

 
 Advanced – Only selection is “Show Cancel Button”, which places the 

“Cancel” button on the Button Bar. The “Cancel” button cancels the 
playing (real or simulated) of an Event. This is for people running 
demonstrations of ShakeAlert UserDisplay and should be ignored by 
other users, as it may result in you not receiving relevant alerts when 
earthquake parameters are updated. It is therefore recommended that 
you do not select to show the Cancel button. Even though instructions 
say you must Save after selecting this option, you only have to restart 
ShakeAlert to enable. 
 

 View – Change or refresh your display using the selections here. 
 Reset Map. Click this option to change your view of the map of 

California back to its default, which is for the entire state to fill the 
window. 

 Clear Display. Clear all alerts and other icons by selecting this option. 
 Toggle FullScreen. Open your program window to fill the screen 

(FullScreen) or click again to return to a smaller window. 
 Status. Opens ShakeAlert Status box, showing the time and servers 

being accessed, and any error messages. You can launch this same box 
by double-clicking the Status Indicator light (the box that should be 
Green when properly connected) on the Button bar. 

 Log. Opens window and displays log messages from the ShakeAlert 
servers. 

 News. (This feature is not fully implemented yet.) Informational 
messages can be sent to ShakeAlert Users, for example, planned tests 
of the system or software upgrades. News items automatically pop-up 
on UserDisplay screens. Past messages can be viewed in the News 
archive, accessible from the top Menu bar by selecting View > News, 
and will be available until the program is restarted. 

 Experimental. Allows you to turn on/off or load historical examples. 
Typically you will not use the Experimental features. 
 Turn History Layer ON. When enabled, shows past events 

(recently received live events as well as replays). Events display as 
color-coded squares sized by magnitude: 

o Red: less than one hour 
o Blue: less than one day 
o Yellow: less than 7 days 
o Grey: more than 7 days 

When enabled, you can turn it off by selecting the same item 
(toggle on/off). 
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 Load Examples into History Layer. Selecting this will load past-
played events (shown as colored boxes; key for the colors detailed 
above), so you can replay them. 

 Turn Intensity Layer ON. Displays color-coded estimated ground 
shaking.  Color is from the Modified Mercalli Intensity Scale 
(MMI).  Warning: this may severely affect performance on 
slower machines. When enabled, you can turn it off by selecting 
the same item (toggle on/off). 

 Turn Station Layer ON. Shows approximate location of 
earthquake stations in field. When enabled, you can turn it off by 
selecting the same item (toggle on/off). 
 

 Help – View documentation about ShakeAlert, including version details, 
copyright, end-user license agreements, and user guide link, and also access 
“Check for Updates” feature. 

 About. Displays ShakeAlert UserDisplay version number and 
copyright information. 

 User Guide. Provides location information for the user guide. 
 README. Displays ShakeAlert UserDisplay README file. Note that this 

file contains useful reference information such as default server 
addresses and program configuration. 

 End User License Agreement. Displays the End User License Agreement 
that you must accept in order to use the ShakeAlert UserDisplay. 

 Check for Updates. Click to have program check for any pending 
updates to the interface. 

 
Button Bar 

 Power-off icon. Clicking this icon will terminate the UserDisplay program. 
You will not get any more alerts until you restart the UserDisplay program. 

 Program Status Light. Click or hover cursor over the status light square, to 
the right of the Power icon, for information regarding connection status. 
 

Green: The communication between the ShakeAlert system and your 
UserDisplay is healthy. You will be able to receive alert messages. 
 
Grey: There are either internal problems with the ShakeAlert system 
or communication problems between the ShakeAlert system and 
your UserDisplay. The communication may still be healthy and you 

may receive alert messages. 
 

Yellow: The ShakeAlert system is only partially operational or there 
is a connection problem to the Network Time Server. You are likely 
to receive alert messages. If an ‘NTP Error’ is showing, try re-

connecting to the time server (UserDisplay menu > Reconnect to Time 
server). 



12 
 

 
Red: There is a connection problem to either the ShakeAlert servers, 
or the UserDisplay program is unable to synchronize with a Network 
Time Server. Make sure your computer has a working Internet 

connection and that no firewalls are blocking that connection. Try re-
connecting to the time server (UserDisplay menu > Reconnect to Time 
server). 
 
Problems connecting to the Network Time Server (NTP) are reflected in the 
color of the program status light, as well as connection issues for receipt of 
ShakeAlert earthquake notifications. If the status light is yellow or red and an 
“NTP Error” is identified, this can lead the event info panel on the left to 
report incorrect warning times. NTP status messages are also included in the 
main log accessible within the program (from the top Menu bar, click View > 
Log). If errors with specific components of the ShakeAlert servers are 
indicated the user does not need to take any action. 
 

 Settings button. This is a shortcut to the Settings dialog box; for details, see 
Top Menu Bar > Edit > Settings. 

 Play Event button. This shortcut is the same as selecting from the Top Menu 
Bar, Replay > Play Event, and launches the Select Event dialog box so you can 
choose a past event to replay. 
 
Advanced Users: XML-messages from the ShakeAlert system that have been 
received by the UserDisplay (while connected to power and internet) will be 
stored on your computer in the “history” folder. When you click on the "Play 
Event" button, an open-file dialog appears. You may click on one of the 
subfolders (the name of these subfolders indicates the ShakeAlert eventID; note 
that this id is different from the eventID that is used in ShakeMap for instance) 
and replay an event by double-clicking on the file with the “.eew” extension. The 
event will not be displayed, if the threshold parameters in “Settings” are not 
exceeded, or if the warning time is zero or negative. 
 
Starting with release v2.4, the ShakeAlert UserDisplay is capable of processing 
and displaying finite fault ruptures and the estimated slip along these ruptures. 
This feature improves intensity estimates at the User’s site for large 
earthquakes (M>6.5). To get more familiar with the finite fault capabilities of 
the UserDisplay, we recommend replaying the examples from the “examples” 
folder. You will find examples for a number of scenario earthquakes in folders 
“FinDer” (Finite Fault Rupture Detector) and “GPSlip.” Click on the .eew file to 
start the corresponding animation. For scenarios in the “FinDer” folder, the 
black line shows the estimated rupture of the earthquake (Figure 5). The 
UserDisplay will use the closest distance between the rupture and your site to 
calculate the expected intensity that you would feel if this event were real. For 
the scenarios in folder “GPSlip”, a color code is used to quantify the amount of 
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slip along the rupture (red: >6 meters, orange: >3 meters, and yellow: >1 meter; 
Figure 6). This color scale is not related to the Mercalli intensity spectrum. 
 

 Silence button quiets a current alarm. You can also use keyboard shortcut 
Ctrl-s. This feature mutes ONGOING alerts, for example to suppress audio 
alerts for distant earthquakes with long warning times that may be irrelevant 
to the User. 

 Mute checkbox will  silence all incoming and simulated alarms. You can also 
mute alarms with the keyboard shortcut Ctrl-m. The “mute” button is useful 
to silence the UserDisplay during a large aftershock sequence after a strong 
earthquake. 

 
Top of Program Status/Shortcuts 
Hover your cursor over the “SA” icon at the top of your computer window (or 
wherever your taskbar or dock is located) to view the ShakeAlert UserDisplay 
version number, current date and time, and current connection status to the 
ShakeAlert servers. The color of the icon shows the UserDisplay status (see the 
Program Status Light section for explanation of color codes). 
 
Some caveats: 

 Linux users have reported that the resulting status message does not wrap 
properly. 

 Windows users will find the SA icon in their Notification Area (see Figure 4). 
Click the up-arrow on your task bar to open the Notification Area.  

 Windows users can customize the system tray so the ShakeAlert icon is 
always visible in the task bar. Right-click the task bar, select Properties, and 
click “Customize…”; on next screen, choose “Show icon and notifications” for 
ShakeAlert UserDisplay (JavaTM Platform). 

 
If you click once (Mac) or right-click (Windows/Linux) on the “SA” icon, you will get 
three shortcuts for the program: 

 
Settings: Displays the Settings dialog box 
Show: Click this to bring the ShakeAlert program from a 
minimized state 
Exit: Exit or shut down the ShakeAlert UserDisplay 

Figure 3. Mac view of SA 
icon; click to view 
shortcuts Figure 4. The SA icon is in the 

Notifications area for Windows users. 
Right-click to see the shortcuts. 
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Figure 5. Slip detection capability of UserDisplay. Color codes the amount of slip along the current fault 
rupture (red: >6 meters, orange: >3 meters, and yellow: >1 meter) 

           
 

Figure 6. Finite fault detection capability of UserDisplay. Black line shows extent of current fault 
rupture. 
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Minimize/Maximize and Close the UserDisplay Window 

Standard operation of UserDisplay is to close the window using the ‘Close Window’ 
button. This will ensure that the UserDisplay will still be running and will pop up 
automatically when an event alert is received that meets the Users’ alert criteria. 
The status icon on your taskbar or dock is the indication that UserDisplay is still 
running. Minimizing the window will lead to the same behavior. (Click the Power Off 
icon on the Button Bar to terminate the program completely.) 
 
Map Navigation 
The above buttons allow you to move around on the ShakeAlert UserDisplay 

 Pan: This button on the far left, when its arrows are clicked, allows you to 
pan east, west, north, south (horizontal and vertical arrows), as well as 
northeast, northwest, southwest, and southeast (corner arrows). Click center 
of this icon to center California in your window. 

 Zoom: Click the Plus magnifying glass to zoom into the display, and the Minus 
magnifying glass to zoom out. 

 Select: Change your cursor to a selector, e.g., to click buttons, select events for 
replay. 

 Area Zoom/Move: Click on the button to use mouse clicks and drags to 
control map positioning. Clicking on the top, bottom or sides of the map area 
will move the map in the desired direction. Clicking and holding the left 
mouse button allows the user to drag to select a desired map area. The area 
is centered on the position of the mouse click. 

 Drag: Click on the hand and then click-hold on the screen, to drag the display 
to where you wish. 

 
5. Alert Information 

When the UserDisplay receives an XML alert message from the ShakeAlert system, 
the following information will be displayed (provided that your thresholds in 
“Settings” are exceeded and the remaining warning time is greater than 1 second; 
Figure 7): 
 
The following symbols appear on the map after an event occurs (see Figure 7): 

 Red star – Location of current event 
 Thick black line – Finite fault rupture 
 Yellow triangles (pointed up) – Approximate location of earthquake sensing 

station(s) 
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 Ground motion symbols, color coded by MMI at each location 
o Small colored circles – Observed ground displacement 
o Slightly larger colored circles – Observed peak velocity or acceleration 
o Small inverted triangles – Predicted ground displacement 
o Slightly larger inverted triangles – Predicted peak velocity or 

acceleration 

 
A. Map: Your location is shown by a blue house, and the estimated location 

of the earthquake by a red star (and/or a thick black line if a finite fault 
solution is displayed). The map is automatically centered on a point 
halfway between the two locations. The yellow and red radiating circles 
show the estimated locations of the P- and S-wave fronts of the 
earthquake, respectively.  
          P-waves, which travel faster than S-waves, rarely cause damage 
because amplitudes are smaller and ground motions are predominantly 
in the vertical direction. The yellow circle, representing the P-wave front 
at a given time, will always be larger than the red circle (S-wave front). 
Damage is typically caused by S-waves.  
         The “remaining time” is the estimated time it will take for the S-wave 
front (red circle) to reach your location. For some events you will also see 
estimated or observed ground motions at various sites shown by filled 

Figure 7. Screen shot of UserDisplay 
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inverted triangles or circles respectively. The map will also display the 
information “Event Cancelled” or “This is a Test”, if an event has been 
cancelled or if a test message was received.  
          You may notice a grey circle around your location. This 
approximates the area where ShakeAlert is extremely unlikely to alert 
you of an earthquake. If an earthquake occurs within this area, you will 
experience the shaking before you could receive an alarm. We are 
working to decrease the radius of this area in future versions of the 
ShakeAlert system. 

 
B. Information Panel: The panel on the left side of the screen gives the 

estimated time (in seconds) remaining until shaking is expected to begin 
at your location, the estimated seismic intensity (MMI scale), and the 
expected magnitude. The Information Panel also gives the Probability of 
Correct Alarm (PCA). We have introduced three PCA levels: “low” 
(0<=PCA<=0.4), “moderate” (0.4<=PCA<=0.7), and “high” 
(0.7<=PCA<=1.0). For further explanation see the section Menus > Top 
Menu Bar > Edit > Minimum Probability of Correct Alarm. 

 
C. Top Panel: the top panel describes the level of expected shaking at your 

site (in words and in color), e.g. “Light Shaking Expected”. 
 
Important: Do not forget to turn on the volume of your computer, and do not 
check the “mute” box at the top of your UserDisplay if you want to hear alert 
messages (siren and voice announcement). 
 
This OperationsGuide was written by M. Böse and J. Andrews (Caltech) with input 
from past and present members of the CISN EEW Group from the following 
institutions: UC Berkeley, California Institute of Technology (Caltech), ETH Zurich, 
USC/SCEC, US Geological Survey. 
 
6. Contact information 

For questions or feedback please contact: 
 
     Margaret Vinci (Caltech, ERA program)   mvinci@gps.caltech.edu  
     Jennifer Strauss (UC Berkeley) jastrauss@berkeley.edu 
     Bill Steele (U Washington)     wsteele@uw.edu 
 
Additional information on the ShakeAlert project can be found at 
http://www.shakealert.org. Thank you very much for your participation. We are 
looking forward to your feedback. 
 
7. Known Issues 

You may encounter one or more of the following issues when running the 
UserDisplay: 
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1) Problem:  Warning time is excessive for location of epicenter 

Solution:  Check the computer’s internal clock. If the computer’s clock is 
incorrect, it will adversely affect the accuracy of warning time. Verify the connection 
to the NTP server to obtain correct time information. 

 
2) Problem:  UserDisplay does not pop up to the front of my screen when 
activated by an event.  

Solution:  When closing the UserDisplay screen use the “red x” in the upper 
right-hand corner. If you close the screen by minimizing the UserDisplay, it will run 
in your tool bar and will pick up the event but not pop up to the front of your screen. 
 
3) Problem:  UserDisplay did not record recent events in your absence. 

Solution:  Turn off “sleep mode” on your computer. 
 
4) Problem:  Computer slow to respond or locks up when UserDisplay is 
running. 

Solution:  Computer resources are insufficient to run the UserDisplay. Close 
non-essential applications. 
 
5) Problem: Not receiving ShakeAlert email notices about planned tests, etc.  

Solution:  Make sure your correct contact information is in our database. 
Contacts:  
     Southern California:  Margaret Vinci (mvinci@gps.caltech.edu) 
     Northern California:  Jennifer Strauss (jastrauss@berkeley.edu) 
     Pacific Northwest: Bill Steele (wsteele@uw.edu) 
 
6) Problem:  Gray circle around Home does not update when location is 
changed in settings window. 

Solution:  Force a redraw of the main window by changing the zoom level or 
pan the display around. Note that the grey zone is only an estimate. It is not used for 
any calculations within the UserDisplay. 
 
7) Problem:  What do the different status colors mean: green, grey, yellow, or 
red? 

Solution:  Click or hover cursor over the status button for information 
regarding connection. See the section Button Bar > Program Status Light for detailed 
descriptions of status light. 
 
8) Problem:  Status is grey, pop-up text says "No information available”, and I 
never get any alerts. 

Solution:  No connection yet. If problem does not resolve itself, check your 
Internet connection. 
 
9) Problem:  Status is yellow and pop-up text says "NTP Error". 



19 
 

Solution:  Problem connecting to NTP server, currently retrying.  Note that it 
may take several minutes for this to update. If the problem does not resolve after 
several minutes, you can use the UserDisplay > Reconnect to Time server menu item 
to try re-establishing your connection. 
 
10) Problem: Status is red and pop-up text says "NTP Error". 

Solution: UserDisplay has given up trying to connect to NTP server. Once 
Internet connectivity has been restored, use the UserDisplay > Reconnect to Time 
server menu item to try re-establishing your connection. If this does not work, try 
restarting the program. The status light may take a minute to update. 

 
11) Problem: Due to network restrictions, I am unable to use the default NTP 
server. 

Solution: Alternative settings for the NTP server can be configured using the 
app.properties file in the installation directory. The line: 

NTPServer=us.pool.ntp.org,ntp-01.caltech.edu 
should be edited. There is no limit on the number of servers that may be included in 
the comma-separated list, but note that the program will attempt to connect to all of 
them, in the order given, each time the clock is checked for synchronization. If 
changes are made to the list of NTP servers, the app.properties file must be 
manually edited and the UserDisplay program restarted for changes to take effect. 
 
12) Problem: The UserDisplay does not pop up even though an event did reach 
my thresholds for magnitude and intensity. 

Solution: The UserDisplay only checks against User thresholds for the first 
message for an event, and if criteria are not met it will ignore the event. If an event 
crosses your thresholds during later updates (as parameters are refined or the 
rupture continues), the UserDisplay will continue to ignore it. This is a known issue 
and will be amended in a future release. Reducing your magnitude and intensity 
thresholds is the only way to currently reduce the likelihood of you missing alerts. 
 
13) Problem: There are no events in my history folder to select for replay. 
 Solution: When the software is first downloaded there will be no events in 
the history folder. This is where alerts are stored that have been received by the 
UserDisplay while it has been running. See the README file in your installation 
directory for instructions on how to copy old history files from a previous version. 
 
14) Problem: Error message appears with the message that you cannot connect 
to the ShakeAlert server. This is most likely due to your institutions’ restrictions on 
port access through firewalls for example. 
 Solution: Launch the Settings dialog using the button on the button bar and 
change the port number from the default 61617 to 443. Press OK, exit the 
UserDisplay and restart. 
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8. Appendix A 

 
ShakeAlert License Agreement and Terms of Service 

 
YOU ARE ADVISED TO READ THIS AGREEMENT FULLY AND CAREFULLY AS IT 

CONTAINS OBLIGATIONS TO BE MET BY YOU AND ALSO INCLUDES A TRANSFER 
OF RIGHTS BACK TO USGS FOR FUTURE DEVELOPED TECHNOLOGY. 

 
This Agreement is entered into between the United States Geological Survey 
(“USGS”), a bureau of the Department of Interior, having offices at 12201 Sunrise 
Valley Drive, Reston, Virginia 20192, and you (LICENSEE). This Agreement covers 
ShakeAlert products and services including the ShakeAlert server connections, data 
streams, the User Display application, other software, algorithms, associated media, 
printed materials, data, files and information and any online or electronic 
documentation (hereinafter “ShakeAlert Materials”). 
 
BACKGROUND 
 
1. The USGS is authorized to develop a system capable of sending earthquake  

warning  notifications as established by the Disaster Relief Act (P.L. 93-288, 

popularly known as the Stafford Act) and the National Earthquake Hazard 

Reduction Program, as enacted by the Earthquake Hazards Reduction Act of 

1977, 42 U.S.C. §§ 7701 et seq. USGS, in partnership with the University of 

Washington, Caltech, UC Berkeley, and the University of Oregon is continuing to 

develop an Earthquake Early Warning (EEW) system. USGS’s specific research 

objective is to develop the capability of issuing an alert within seconds of 

detecting an earthquake, thereby providing warning before destructive shaking 

arrives. This alert is currently delivered through a prototype system 

encompassed by the ShakeAlert materials, provided under this license. 

 
2. This agreement is entered into under the authority of the Federal Technology 

Transfer Act of 1986, codified in 15 USC 3710(a), as amended. The purpose of this 

agreement is to further the research and development of the ShakeAlert Materials 

through a “beta test” that will provide valuable feedback from each Licensee 

regarding the functionality of the ShakeAlert Materials.  

 
3. The ShakeAlert Materials licensed under this agreement include real-time data 

streams that may include parameters derived from ground motion records, 

ground motion estimates, or earthquake source information including origin 

time, location, magnitude, and fault rupture description and duration. These 

information streams begin shortly after an earthquake starts and update as the 

earthquake develops.  
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4. The ShakeAlert Materials licensed under this agreement include an application 

currently referred to as UserDisplay that may run on a Licensee’s computer and 

presents visual and audio information about the earthquake and when and how 

strong shaking will arrive at the user’s location.  

AGREEMENT 
 
For good and valuable consideration, the receipt and sufficiency of which are 
hereby acknowledged, the parties agree as follows: 

1. License Grant. USGS grants LICENSEE, and LICENSEE hereby accepts, a non-

exclusive, non-commercial, non-transferable, revocable without cause license 

to use ShakeAlert Materials provided that: 

a. LICENSEE shall not copy, modify, reverse engineer, publish, rent, 

lease, loan, sublicense, or distribute ShakeAlert Materials to any third-

party without the prior written consent of USGS; 

b. Shall not offer for sale, advertise, distribute or otherwise publically 

offer any product or service relating to the ShakeAlert Materials;  

c. LICENSEE shall not allow ShakeAlert Materials to be accessed over a 

network or the Internet in a manner that would allow users to access 

ShakeAlert Materials who are not employed by LICENSEE, without the 

prior written consent of USGS; 

d. LICENSEE shall not interfere with or disrupt USGS or ShakeAlert 

servers or networks or servers or networks connected to them, or 

disobey any requirements, procedures, policies or regulations of 

ShakeAlert servers or networks;  

e. LICENSEE is limited to five (5) concurrent connections to ShakeAlert 

servers; and 

f. LICENSEE may only use ShakeAlert Materials for the fields of use 

identified in Appendix A. 

 
2. Maintenance and Support. USGS is under no obligation to provide 

maintenance for ShakeAlert Materials or notify LICENSEE of any fixes, 

patches, or updates to ShakeAlert Materials. If, in its sole discretion, USGS 

makes an update available to LICENSEE, it shall be deemed incorporated into 

the ShakeAlert Materials and subject to this Agreement. USGS reserves the 

right to make any and all changes to ShakeAlert Materials that it deems 

necessary to maintain and improve the function of the system. 

 
3. Feedback. As consideration for this Agreement, the LICENSEE shall, upon 

request of USGS, provide suggestions and feedback regarding the ShakeAlert 
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Materials, including, but not limited to, functionality, design, usability, bugs, 

and results of any testing performed by Licensee.  

 
4. Passwords and Security. LICENSEE is required to register as an authorized 

user for access to ShakeAlert Materials. Registration will include a username, 

password and contact information (“User Credentials”). For convenience, 

usernames shall reasonably reflect the name of the LICENSEE. User 

Credentials must be kept accurate and up-to-date. Licensee is responsible for 

maintaining the confidentiality of its User Credentials and shall not share its 

User Credentials with anyone or use the User Credentials of others. USGS 

reserves the right to disable, delete or change Authorized User Credentials at 

any time and for any reason without notice. 

 
5. Attribution. If licensee publishes research or otherwise publically discloses 

information related to the ShakeAlert Materials that is not prohibited by this 

Agreement, then LICENSEE shall give appropriate credit to the USGS as the 

source of ShakeAlert Materials. LICENSEE may do so in any reasonable 

manner, but not in any way that suggests the USGS or U.S. Government 

endorses the LICENSEE or its products, services or opinions. 

 
6. Prohibition on the Distribution of Warning Signals. LICENSEES are not 

authorized to transmit messages, notifications, alerts, or warnings derived 

from the ShakeAlert Materials to the public unless specifically agreed to in a 

separate written agreement with USGS. 

 
7. No Warranties Unless Expressly Provided. ShakeAlert Materials are 

licensed for the purpose of continued research and development and, except 

as specifically stated in this Agreement, the parties make no express or 

implied warranty as to any matter whatsoever, including the conditions of 

the research or any invention or material, whether tangible or intangible, 

made or developed under or outside the scope of this Agreement, or the 

ownership, merchantability, or fitness for a particular purpose of any 

research, invention or material, or that a technology used by a Party in 

connection with the ShakeAlert Materials, or the ShakeAlert Materials, does 

not infringe any third-party patent rights. Furthermore, USGS does not 

warrant that ShakeAlert Materials will function uninterrupted, be error-free 

or that any errors will be corrected. 

 
8. Licensee Warranties.  The Licensee warrants that: 

 

http://creativecommons.org/licenses/by/4.0/
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a. It has authority to enter into this Agreement;  

b. The signatory has the authority to sign on behalf of the Licensee; and 

c. The Licensee or any of the Licensee’s personnel involved in 

performance under this Agreement are debarred or suspended by any 

agency of Government. This warranty requires the Licensee to notify 

USGS if Licensee, or any personnel, becomes debarred or suspended 

during the term of this Agreement. 

 
9. Indemnity. LICENSEE shall indemnify, defend, and hold harmless the U.S. 

Government, its agents, officers, and employees against any and all claims, 

suits, losses, damage, costs, fees, and expenses arising out of or in connection 

with LICENSEE’s use of ShakeAlert Materials pursuant to this Agreement. 

 
10. Copyrights. Licensee shall not claim, file for or otherwise acquire an interest 

in any copyrights in the Shake Alert Materials. However, work performed by 

Licensee by virtue of its use of ShakeAlert Materials under this Agreement 

may generate copyrightable works of the Licensee, including software. 

Licensee grants to the Government a nonexclusive, irrevocable, paid-up 

license in such copyrighted works resulting from the work accomplished by 

virtue of this Agreement. Collaborator shall include the following statement 

on any copyrighted work(s) created by virtue of this Agreement: “The U.S. 

Government has a copyright license in this work pursuant to an agreement 

with the U.S. Geological Survey, a bureau within the Department of Interior.”  

 
11. Patents and Trade Secrets. Licensee shall not claim, file for or otherwise 

acquire an interest in any patents or trade secrets for the ShakeAlert 

Materials. However, work performed by the Licensee by virtue of its use of 

the ShakeAlert Materials under this agreement may generate patentable 

materials and/or trade secrets of the Licensee.  The Licensee grants to the 

Government a nonexclusive, nontransferable, irrevocable, paid-up license to 

practice or have practiced any invention made by licensee by virtue of this 

Agreement, regardless of whether the invention is patented, claimed as a 

trade secret or otherwise proprietary to Licensee, throughout the world by 

or on behalf of the Government for research or other Government purposes. 

Any patent application filed for an invention conceived or reduced to practice 

in the performance of this Agreement shall contain the following statement: 

“This invention was created in the performance of an agreement with the U.S. 

Geological Survey, a bureau within the Department of Interior, which has 

certain rights in this invention.” 
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12. Term and Termination. This license is perpetual unless terminated by 

either Party. USGS may terminate at any time without reason and may 

terminate regardless of whether LICENSEE is in breach of this Agreement. 

Termination shall be exercised in the sole discretion of USGS and USGS shall 

not be liable for any damages claimed by Licensee as a result of the 

termination of this Agreement. Upon termination, LICENSEE shall 

immediately cease utilizing ShakeAlert Materials and return to USGS or 

destroy all copies of the ShakeAlert Materials in accordance with instructions 

from USGS.  

 
13. Governing Law. The validity and interpretation of this Agreement are 

subject to interpretation under Federal Law.   

 
14. Entire Agreement. This Agreement represents the entire understanding of 

the Parties, and supersedes all previous communications, written or oral, 

relating to the subject of this Agreement. If either Party desires a 

modification to this Agreement, the Parties shall, upon reasonable notice of 

the proposed modification by the Party desiring the change, confer in good 

faith to determine the desirability of the modification.  No modification shall 

be effective until a written amendment is signed by the signatories to this 

Agreement or their designees. 

 
15. Survivability.  When necessary to effectuate the intent of this Agreement, 

individual provisions shall survive expiration or early termination. 

 
16. Export Controls.  Collaborator agrees to comply with U.S. export law and 

regulations. 

 
17. Severability. If a provision of this Agreement is found illegal or 

unenforceable, it will be enforced to the maximum extent permissible, and 

the legality and enforceability of the other provisions of this Agreement will 

not be affected. 

 
By clicking the “I ACCEPT” button, you are agreeing to all of the terms, conditions 
and obligations included in this ShakeAlert License Agreement and Terms of 
Service. 


